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■  If you’re upgrading from Clients & Profits 4.x or earlier, please call the C&P Help-
desk at (800) 521-2166 for special upgrade instructions.

■  The Clients & Profits X web site has news, tips, tech notes, FAQs, and more: 

www.cnp-x.com/support

For help using any part of Clients & Profits X, click the             button from 

any window to open the online user guide. This web-based user guide fea-

tures step-by-step instructions, explanations, tips, demonstrations, and links 

to FAQs, tech notes, and tutorials from the Clients & Profits X web site. It’s 

continually updated, so it’s more timely and helpful than a printed user guide.
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Introduction About the Database

Clients & Profits X is a tenth-generation job tracking, costing, billing, and 
accounting system for advertising agencies. The system is multi-user and 
cross-platform, allowing any number of Mac OS X and Windows XP/Vista 
users to work together on the same database of clients, jobs, etc.

There are four editions of Clients & Profits X:

Clients & Profits Classic X is an ultra-low maintenance, entry-level agency 
management system for ad agencies and design firms that need basic job 
tracking, media buying, job costing and billing, and financial accounting. 
Designed for agencies with 5-15 employees.

Clients & Profits Pro X is a professional-grade agency management system 
that features comprehensive media planning, buying and WIP accruals, a 
more powerful financial accounting system, and custom reporting. Includes 
support for MySQL 5 and Microsoft SQL Server 2008 Express. Designed for 
agencies with 15-75 employees.

Job Tracker X is a job tracking, costing, and chargeback system tailored 
for corporate design, graphics, and marcom departments. Cost and billing 
data can be easily integrated with corporate accounting systems via ODBC. 
Includes support for MySQL 5 and Microsoft SQL Server 2008 (including the 
free Express version). 

Clients & Profits X : Enterprise Edition is an enterprise-class application 
based on Microsoft SQL Server 2008. C&P X : Enterprise Edition is a highly 
scalable, customizable agency management system for mid-size agencies 
with 25-250 employees in multiple locations.

All versions of Clients & Profits X share a common user interface, work f 
low, and database architecture. In this guide, all versions are referred to as, 
simply, Clients & Profits X.

The Clients & Profits X installer is available via download only. A single 
installer will install any of the four editions. The edition you’ll use is enabled 
when during the web-based software registration (see page 12). 

Clients & Profits X should be installed separately on every Mac or PC that 
will run it (i.e., don’t run the software from the file server). 

Clients & Profits X features a built-in 
relational database that is extremely 
easy to set up and needs virutally 
no maintenance, but is not client/
server. 

SQL-based client/server databases 
offer better performance, reliability, 
and accessibility that make them 
a better choice for larger shops. 
However, SQL databases are complex 
and require experienced database 
administrators to manage them.

■ C&P Classic X now fully supports 
MySQL, but does not support Micro-
soft SQL.

MySQL 5: C&P X supports both the 
free community version and com-
mercial “enterprise” version. 

Microsoft SQL Server 2008 Express: 
C&P X supports this free version 
of SQL Server 2008. Each Mac user 
needs a $30 ODBC driver from www.
actualtechnologies.com.

Microsoft SQL Server 2008: Both Job 
Tracker X and  Enterprise Edition 
support this industry-standard, high-
performance database server.

■  No SQL database is included with 
Clients & Profits X. If you use SQL, 
you are responsible for choosing, 
installing, and configuring the da-
tabase. The C&P Helpdesk does not 
offer technical support for hardware, 
system software, or SQL databases.

Introduction

System Requirements

All versions of Clients & Profits X run 
well on a wide range of computer 
models. Because it’s a relational 
database, performance is highly 
affected by the speed of your file 
server and your network. 

File Server:  Clients & Profits X 
requires its own dedicated file server. 
If your shop is 100% Mac, use Mac 
OS X Server 10.4.4 (or higher). To use 
SQL Server 2008 or SQL Server 2008 
Express, you need a Windows server. 
Linux servers are not supported. 

Workstations:  Any Mac running Mac 
OS X 10.4 (or later) or any PC running 
Windows XP/Vista/7. C&P X 10.3 is 
a universal binary application so it 
runs natively on an Intel Mac.

■  For detailed recommendations, 
see: www.cnp-x.com/sales/sys-
tem_recs.html

■  For up-to-date technical news, 
visit: www.cnp-x.com/support/
sys_mgr_news.html

Sending e-mail:  C&P X can send 
e-mail notifications to staff members 
automatically. To enable e-mail, C&P 
X needs to connect to a valid SMTP 
mail server. 

Need installation help? Call the C&P Helpdesk at (800) 521-2166
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Software Registration and 
the Trial Demo

Clients & Profits X runs as a free trial 
demo for 60 days —or until your soft-
ware registered. The trial demo has 
very few restrictions—there are no 
limitations to the number of clients, 
jobs, costs, and billings you can add, 
as well as the number of reports you 
can print. 

■  The trial demo allows up to 10 
users to share a database at the 
same time.

■  Your company name will not 
appear on reports, estimates or 
invoices in the trial demo.

You can license Clients & Profits 
X any time during the 60-day trial 
period. The software registration pro-
cess will validate your installation 
and remove the demo limitations. 
There is nothing to reinstall. Once 
your trial period has ended, your 
demo database can’t be used unless 
you buy Clients & Profits X. Your 
demo database can be opened at any 
time thereafter; no data is lost.

Clients & Profits X uses an internet-
based registration system to validate 
each software installation.
The software registration process 
does two things:  

Registration only runs once for 
each database you use. Only C&P 
X system managers with admin ac-
cess can register, while anyone can 
activate. Clients & Profits X must be 
licensed before a database can be 
registered.

Activation (see page 12) serializes 
a user’s C&P X application (which 
controls how many users can share 
the database) and sets which edi-
tion (i.e., C&P Classic, C&P Pro, Job 
Tracker, or Enterprise Edition) will 
be used.

Learning C&P X

Clear, concise learning materials 
are available to help you and your 
staff become C&P X pros quickly:

Demo Guide  This guide walks 
you through the Clients & Profits 
X basics, including opening jobs, 
tracking time, and printing invoices.

Feature Guide This guide offers an 
illustrated overview of the best 
parts of C&P X. It offers screen 
shots and captions for commonly-
used features, but not step-by-step 
instructions. For new buyers, one 
printed Feature Guide is included 
for each user licensed.

User Guide  The web-page user 
guide includes step-by-step instruc-
tions for every C&P X function. 
The user guide can be accessed 
by any web brower by clicking on 
any window’s Help button. Most 
pages feature links to tutorials, 
sample reports, and other learning 
resources.

Database Guide  Designed for 
database managers, this guide 
describes how the built-in Clients 
& Profits X database works in 
technical detail. It includes tips for 
preventing corruption and sugges-
tions for troubleshooting problems. 
Not needed for SQL installation.

www.cnp-x.com/support  The 
online helpdesk has an extensive 
knowledge base of tutorials, FAQs, 
tech notes, training videos, and 
more available to support subscrib-
ers. You can also post bug reports 
and wish list requests and sign up 
for the C&P User Guide here. Your 
e-mail address is your login ID and 
everyone in the office uses the 
same company-wide password.

Web Accessibility

Clients & Profits X features a free 
built-in web-based time card that 
allows a virtually unlimited number 
of staff members to track their time 
from a web browser, whether they’re 
inside the office or on the road.

The web-based time card requires a 
dedicated Mac or PC with a static IP 
address. If users need to access their 
time card from home, an airport, or a 
client’s office then the server needs 
an outside IP address. 

For users who need to add proposals, 
open new jobs, edit estimates, enter 
expense reports, and more outside 
the office, you’ll want My Clients & 
Profits! X (sold separately).

My Clients & Profits! X is an add-on 
web server that offers staff members, 
vendors, clients, and freelancers 
access to the work they do from any 
web browser.

My C&P! X is a self-contained web 
server and requires a dedicated Mac 
or PC with a static IP address. It 
features user-based logins and ac-
cess privileges separate from Clients 
& Profits X. The web server offers 
web-based remote administration, 
full activity logging, and account and 
password expirations. The My C&P! X 
server takes one of your concurrent 
user licenses, but allows a virtually 
unlimited number of remote users. 
For information, visit www.cnp-
x.com/my

■  To see My Clients & Profits! X in 
action, try the live demo: 

http://my.clientsandprofits.com

Introduction

How to Upgrade

Clients & Profits X 10.3 is 100% 
compatible with databases created 
by previous versions of Clients & 
Profits. A automatic conversion pro-
cess is required to make it work with 
the new features found in the C&P X 
10.3 upgrade. 
 
■  Before upgrading a database, be 
sure to BACK IT UP. If the upgrade 
process stops for any reason, the 
database will be unusable. For better 
performance, do not convert your 
database over the network. Also, no 
one can use the database during the 
upgrade conversion. 

■  Everyone must upgrade to C&P X 
10.3 at the same time. 

Upgrading from C&P X 10.0.x (or 
later)  A quick data reorganization 
is needed. When you open a C&P X 
10.0.x or 10.3.x database for the first 
time, C&P X 10.3 will prompt you to 
convert it.

Upgrading from C&P 5.x Before up-
grading, be sure the database name 
ends in .df1 (e.g., DATA2006.df1). 
If you’re not using the C&P 5.0.8, 
download the Prep C&P X Database 
utility then follow its instructions. 
The database conversion can take 
between 10 minutes to several hours 
depending on its size. This is a one-
time process that must be performed 
on each database you use. No data 
is lost. Once converted, the database 
can be opened and used by any C&P 
X user. Custom reports and plug-in 
applications will have to be recre-
ated for Clients & Profits X.

■  Once the database is converted 
for 10.3, it is not advised to connect 
to it with older versions of Clients 
& Profits.

Upgrading from older versions of 
Clients & Profits Call the Helpdesk 
for specific instructions for your ver-
sion of Clients & Profits.
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To install updatesInstalling Clients & Profits X on 
Mac OS X

To install the Clients & 
Profits X software

1  Download the Clients & Profits 
X 10.3 installer for Mac OS X from 
www.cnp-x.com.

2  Double-click on ClientsProfitsX 
10.3.dmg file to mount the installer. 

The Installer window will open, 
prompting you to drag the Clients 
& Profits X application to your hard 
disk.

3  Drag the C&P X 10.3 application 
into your Applications folder.

Clients & Profits X 10.3 is now ready 
to use.

If you want C&P X to appear in your 
Dock, open your Applications folder 
then drag the C&P X application onto 
your dock.

Clients & Profits X is installed separately on every Mac OS X workstation 
that needs it. The installation steps are straightforward: simply download the 
software, run the Clients & Profits X installer, then follow the prompts. 
 
The Clients & Profits X 10.3 installers are available from the Clients & Profits 
X web site (www.cnp-x.com/downloads). They are not available on disc.

■  Clients & Profits X does not need to be installed on the file server. The 
software always runs from user workstations.

■  Clients & Profits X does not modify your system software. 

You can use Clients & Profits X on any Macintosh computer (including Intel 
Macs) running Mac OS X 10.4 (or later).

Clients & Profits X is a native application for Mac OS X 10.4 Tiger and 10.5 
Leopard and a universal binary for the Intel-based Mac. Unlike previous Cli-
ents & Profits releases, it does not run in the Mac OS 9 classic environment 
in Mac OS X.

To remove the Clients & Profits X 10.3 software, simply drag the application 
to the Trash. 

Installing Clients & Profits X on Mac OS X

Clients & Profits X has a built-in 
web-based software updater that 
makes it easy to keep up-to-date.  

1  Start C&P X, open your database, 
then log in.

2  Choose Setup > Software Updates.

■  System managers can restrict 
access to software updates for 
individual user in Users, Access & 
Passwords > Menus.

If you have access to software up-
dates, Clients & Profits X will check 
for new versions each time your start 
the application. If a new update is 
available, you’ll need prompted to 
install it.

For help using any part of Clients & Profits X, click the help button from any 

window to open the online user guide. This web-based user guide features 

step-by-step instructions, explanations, tips, demonstrations, and links to 

FAQs, tech notes, and tutorials from www.cnp-x.com/support. The web site is 

continually updated, so it’s more timely and helpful than a printed user guide.
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Installing Clients & Profits X on 
Windows 

To install the Clients & Prof-
its X software

1  Download the Clients & Profits 
X 10.3 installer for Windows from 
www.cnp-x.com.

2  Double-click on the ClientsProf-
itsX 10.3.exe file. 

The Installer will prompt you to 
choose a destination for the new 
C&P X folder. The Program Files 
folder on your C: drive is chosen 
automatically, but any volume can 
be chosen.

3  Follow the prompts to finish the 
installation.

■  Any saved custom reports, plug-
ins, or other files can now be moved 
into the new C&P folder.

Clients & Profits X is installed separately on every Windows workstation that 
needs it. The installation steps are straightforward: Run the Clients & Profits X 
installer then start Clients & Profits X.

The Clients & Profits X 10.3 installers are available from the Clients & Profits 
X web site (www.cnp-x.com) and are not available on CD.

■  Clients & Profits X does not need to be installed on the file server. Nor-
mally, the software always runs from a user’s PC.

Clients & Profits X does not install any Windows system files, except for four 
special cross-platform fonts (see below). It doesn’t modify your Windows con-
figuration. Also, Clients & Profits X takes advantage of extra RAM by printing 
larger reports faster.

You can use Clients & Profits X on any late-model PC (or better) running 
Windows XP or Vista. 

The Installer copies a special program that can uninstall Clients & Profits X. 
The uninstaller program removes the Clients & Profits X application and all of 
its files. 

■  The Uninstaller won’t delete the C&P folder if it contains your database, a 
custom report, or any other user files. This is a safety feature to prevent the 
database from being accidently deleted. If you’ve changed the contents of the 
C&P folder, you’ll have to trash it manually.

To install updates

Clients & Profits X has a built-in 
web-based software updater that 
makes it easy to keep up-to-date.  

1  Start C&P X, open your database, 
then log in.

2  Choose Setup > Software Updates.

■  System managers can restrict 
access to software updates for 
individual user in Users, Access & 
Passwords > Menus.

If you have access to software up-
dates, Clients & Profits X will check 
for new versions each time your start 
the application. If a new update is 
available, you’ll need prompted to 
install it.
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Sharing Clients & Profits X

Sharing Clients & Profits X

Clients & Profits X is a true multi-user relational database. This means it is 
designed to share the same database among dozens of active users.  Because 
Clients & Profits X is a cross-platform application, users with either Macs or 
Windows-based PCs can share the same database simultaneously.

Multi-user Clients & Profits X works with a variety of industry-standard file 
servers. Windows Server 2003 and Mac OS X Server 10.4.4 (or later) provides 
cross-platform access to both Macintosh and Windows users. (As an option, 
Job Tracker and Clients & Profits Pro can use MySQL for improved perfor-
mance and reliability; see below.)

Like earlier versions, Clients & Profits X isn’t installed or run from the file 
server. Instead, it is installed only on user workstations. Only the database is 
stored on a shared folder on the server. Anyone who uses Clients & Profits X 
starts it from their own computer, then opens the shared database from the 
server. All of the  work is entered and processed (including printing reports) 
from the user’s computer. The file server only saves the data.

The shared database created by Clients & Profits X should be stored on the 
file server, where it can be accessed by anyone who needs it.

■  For best performance and security, a file server dedicated to the Clients & 
Profits database is required.

■  For up-to-date system recommendations, please visit our web site:
www.clientsandprofits.com/what-is

To accommodate PC users, your database needs to have a DOS file extension. 
So if your database is now named MarCom2008 DATA, it must be changed to 
MRCM_08.DF1 or something like it.  The Macintosh and Windows versions of 
Clients & Profits X recognize files ending with .DF1 as the database.

There is nothing to set up, initialize, or configure to share Clients & Profits 
X.  The software needs to be installed on any computer that needs it, while 
the database is kept in the shared folder on the file server. Clients & Profits X 
uses a last-entered, last-saved method for updating records; if several users 
are editing the same record, the last person who enters data is the one whose 
changes are saved.

Concurrent user limits

Clients & Profits X is licensed based on concurrent number of users for all 
platforms. This means only a certain number of Mac and Windows users can 
access the same database at the same time. C&P Classic X supports up to 15 
concurrent users. C&P Pro X and Job Tracker X support up to 100 users. 

For example:  If you bought a 10-user version, any ten Mac and/or Windows 
users can share your database. These ten users could be anywhere in the 

company, from account service to accounting. If an eleventh user tries to 
open Clients & Profits X, however, he or she will get a warning message—
something like “too many people are using Client & Profits.” That person can’t 
share the database because there are no open “slots” to use. When someone 
quits Clients & Profits X, a slot becomes available. So as some people quit the 
program, others can use it.  

You can easily increase the number of users who can open the database by 
purchasing a license for additional users by calling Clients & Profits Sales at 
(800) 272-4488. 

■  If you have enabled the built-in web-based time card, you will need to 
dedicate one full-time user to the web timecard server. See your Feature Guide 
for more information.

Performance issues

Since Clients & Profits X is a multi-user database, it is very different from 
typical programs such as Word, Quark, and Photoshop. These programs aren’t 
multi-user, so the work you do is saved into your computer’s memory—or onto 
your hard disk. These programs are single-user. No one can work on them 
while you’ve got them open.  

The work you do in Clients & Profits is saved automatically to the file server 
when you press Return/Enter (that’s why there’s no Save command). This lets 
other people see, change, and print the information you’ve entered immedi-
ately. Since everyone’s working on the same clients, jobs, costs, and billings 
this system keeps everyone up-to-date.

Because Clients & Profits X is disk-based, its performance is affected by the 
speed of your file server and network, and less affected by your own computer. 
When the server is busy, you’ll slow down. As you add additional users to your 
database, you’ll see somewhat slower overall performance. The slower speed 
will be more apparent during peak periods, such as Friday afternoon when 
everyone typically enters their weekly time sheets. The only way to improve 
the system’s performance is to use faster hardware.

■  The Clients & Profits X Database Guide, which provides a comprehensive 
guide to managing the database, is available from the C&P web site: www.
cnp-x.com/support/database_guide

Security issues

The network server software (e.g., Windows 2003 Server or Mac OS X Server) 
controls the access users have to the database itself. Once a user can open the 
database, he or she must enter a valid set of initials and password to actually 
work with clients, jobs, costs, and billings.  

Clients & Profits X and the network server provide a high level of security for 
your valuable information. However, the designated system manager must 
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actively manage the server, the database, and its users to prevent security 
lapses and damaged data.

It’s important that everyone who can use Clients & Profits X have a unique, 
private password.  This password should be changed frequently (such as every 
month or quarter), and especially when an employee leaves.

■  A reliable backup system is absolutely critical to prevent time-consuming 
loss of data. Any kind of backup system (e.g., external drive, DVD-R, tape) will 
work if it is used nightly. Also, make sure you have the database regularly 
stored on different types of media (such as an external hard drive).

Setting up the file server

Regardless of which file server you choose, setting up the Clients & Profits X 
database is the same.  

■  If you’re using MySQL or SQL Server, skip these steps. 

1  Create a folder (or directory) on a server volume for Clients & Profits X users 
only.

This folder/directory should only contain the Clients & Profits X database 
and other shared files, such as custom reports.  Don’t copy the C&P Player or 
program here; they should only be installed on the workstations themselves. 
Otherwise, someone may run the program from the server and cause perfor-
mance and data reliability problems.

2  Name this folder (or directory) something obvious to your users.

People need to intuitively know where the database is stored, so name it 
something like “C&P Data” or “Accounting Database.”  

3  Use the server’s administrative tools to establish read/write access privi-
leges for this folder. Only people who will use Clients & Profits X should be 
able to see it.

4  Move your database into the shared C&P folder.

Once the database is moved to the file server, anyone with the right access 
privileges can start using Clients & Profits X. 

Database integrity

The Clients & Profits X database is designed to be reliable over many years 
of use. Unlike other programs you use, the database file is used every day, all 
day, by many people. It can become very large over the years, which makes it 
vulnerable to hardware problems like disk fragmentation.  

■  The Clients & Profits X database segment has a maximum size of 256 

megabytes. To store more than 256 MBs of data, you’ll need to use MySQL, 
Microsoft SQL Server 2008 Express, or Microsoft SQL Server 2008.

Because you’ll use the same large file every day, there’s a greater probability 
that you’ll have problems with Clients & Profits X than with other programs. 
So its important that the system manager have a procedure for tracking prob-
lems with the database—no matter how small.  

Each time a computer crashes while using the database, there’s a chance that 
it can become damaged. Over time, these incidents can corrupt the database, 
making it behave inconsistently. Most damage can be easily fixed using the 
built-in Data Utilities (which includes the daily Quick Check).

The system manager should be aware of day-to-day changes in the database’s 
performance. Keep a log of events like seemingly random freezes, error mes-
sages, and inconsistencies in how the program works. These will be clues to 
diagnosing the problem—and finding a solution before any data is lost. When 
combined with a dependable backup system, you’ll prevent the expensive 
downtime when Clients & Profits X is unavailable.
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Starting Clients & Profits X

Starting Clients & Profits X

Whether you’re using Macs or Windows, Clients & Profits X starts like any 
other application.

To start Clients & Profits X

1  Double-click on the Clients & Profits X application. 

If you’re using the software for 
the first time, it runs as a trial 
demo and you will be prompted 
to choose an edition to use.

2  At the C&P X Trial Demo 
window, click on either C&P 
Classic, C&P Pro, Job Tracker, or 
the Enterprise Edition. 

While running the trial demo 
you can do virtually everything. 
A small tutorial database is 
included to get started, but you 
can create a new database for 
your own clients, jobs, costs, 
and billings. Once you have 
licensed Clients & Profits X and 
registered your database (see 
page 12), activating your workstation will set the edition automatically and 
enable multi-user access to your database. 
 
You’ll then be prompted to choose a database then log in. The Introduce 
Yourself window (see above) lists the databases you’ve recently used, as well 
as lets you connect to SQL databases. 

3  Click the Open Database button, then select the c&px-tutorial.df1 database, 
then click Open. 

4  Click the Open Database button, select the c&px-tutorial database, then 
click Open.  

5  Enter your initials as DEMO and your password as demo then click Connect. 

You are now connected to the tutorial database on your hard disk. Other da-
tabases can be opened, including those on your file server, by repeating steps 
2-3. Only one database can be opened at a time.

To start a new database

Before starting to enter your own work, you’ll need create your own database. 

■  If you’re using SQL, new databases need to be created first by your DBA 
using the server’s admin tools (see page 18-24). These steps do not apply.

1  From the Introduce Yourself window, click on the New Database button. 

2  Name the database then choose its destination on the server.

You can name your database anything you want, but make sure it’s clear to 
your users that it is the produc-
tion/accounting data—and not 
some easy-to-trash file. For 
example: Marcom 2008 DATA. 

If you’re using Clients & Profits 
X on Windows, or are sharing the 
database between Macs and PCs, 
your database needs a  file name 
extension (e.g., MRCM08.DF1).  
The .DF1 is very important, since 
it identifies this file to Clients & 
Profits X as the database.

3  Click Save.

4  Enter the initials MGR then 
click Connect. 

Every new database has a system manager account MGR with no password. 
You should delete this temporary MGR account after you’ve added yourself 
and all of your co-workers as Clients & Profits X users.

Every new database gets a standard collection of status codes, G/L accounts, 
groups, tasks, etc. but is otherwise empty. You can edit and delete any of the 
standard settings in a new database, as well as add your own information.  

While most shops need only one database, Clients & Profits X can support 
several different databases. This means the accounting department can use 
the same Clients & Profits X program to handle several different companies or 
divisions, such as output houses and graphic design shops. Each database is 
independent of the others, and they can’t be consolidated.  

■  Any number of new databases can be created from Clients & Profits X as 
long as they are used by the same staff in the same location. If you need dif-
ferent databases for separate businesses or divisions, those groups need their 
own licensed edition of Clients & Profits X.

5  The new database now needs to be completed. The New Database Flow 
Chart (see right) describes what to do next. 
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1.  
Add users, passwords, and access privileges

2.
Add clients, vendors, and staff members

3.
Add your chart of accounts

4.
Add tasks to your Task Table

5.
Add production and billing 

status codes

6.
Add job types/spec sheets, 

then set your job numbering preferences

7.
Enter your preferences:

Accounting periods, purchase order numbering, and 
department information

8.
Now you’re ready for:

Jobs, costs, time, and billing

New Database Flow Chart
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Software Registration

Clients & Profits X uses an internet-based registration system to validate each 
software installation. The registration process makes your trial demo software 
fully functional. 

Registration is a one-time process that’s required for each database after 
you purchase Clients & Profits X. After being successfully registered, each 
workstation in the organization needs to be activated. The activation process 
automatically initalizes the C&P X serial number, which controls multi-user 
access to your database. Activation also determines the Clients & Profits X 
edition (e.g., C&P Classic, C&P Pro, 
Job Tracker, or Enterprise Edition) that 
you’ll be using.

You can use Clients & Profits X for 
multiple databases as long as they are 
used by the same people in the same 
location (as described in our license 
agreement). Each database needs 
to be registered and activated from 
the Software Registration window. 
Here are some things to know about 
software registration:

■  Your organization name will not 
appear on printed reports, estimates, 
and invoices until you’ve purchased 
Clients & Profits X and licensed the 
database.

■  You can license Clients & Profits X 
any time during the free 60-day trial 
period. 

■  The software registration process will validate your installation and remove 
the demo limitations. There is nothing to reinstall. 

■  Once your trial period has ended, your demo database can’t be used unless 
you buy Clients & Profits X. Your demo database can be opened at any time 
thereafter; no data is lost.

Clients & Profits respects your privacy. No other information about your orga-
nization or your database is transmitted or stored. Your encrypted database 
information is used for software registration purposes only.

To register your database

1  Choose Setup > Software Registration

The Software Registration window opens. 

2  Click the Register button. 

The Register Database window (see right) prompts you for the database’s 
setup information, including its system manager.

The organization name and address identify this database. The name appears 
at the top of every report. The C&P Helpdesk ID identifies your Clients & Prof-
its X software installation. The C&P Client # is your customer number in our 
CRM system. Both are printed on your sales invoice or are available by calling 

the Clients & Profits Helpdesk at (800) 
521-2166. 

3  Press Return (or click Register) to 
send your registration information to 
the C&P Helpdesk.

Your registration information—and 
nothing else—is encrypted then 
e-mailed to the C&P Helpdesk for vali-
dation. Once your registration details 
have been validated, you’ll be notified 
by e-mail to activate your workstation. 

To activate your workstation

1  Choose Setup > Software Registra-
tion

2  Click the Activate Workstation 
button.

Your database’s organization name and address will be updaed using the 
information your sent from the Registration window. Activation also serializes 
your Clients & Profits X software, which enables the database to be shared 
between many users. (To add additonal users later, you only need to call C&P 
Sales at (800) 272-4488 then activate the workstations again.) Your remaining 
users can now activate their workstations and start using Clients & Profits X. 

Need registration help? Call C&P Sales at (800) 272-4488
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Software Updates

Clients & Profits X is self-updating, automatically installing new feature 
enhancements, bug fixes, and patches as they are made available—with a 
single mouse click. 

Unlike previous versions of Clients & Profits which required update installers 
or software patches, Clients & Profits X uses a web-based update server to 
download feature enhancements, bug fixes, and patches directly into each 
copy of Clients & Profits X.

Software updates are avail-
able to all Clients & Profits X 
registered users with current 
support subscriptions and to 
trial  demo users.

Only users with access to Soft-
ware Update can update their 
own copy of Clients & Profits 
X. For better security, access 
to Software Update is turned 
off by default in the Users, Ac-
cess & Passwords window. Ac-
cess to software update can be 
assigned on a per-user basis, 
giving the system managers 
better control over how Clients 
& Profits X is updated.

System managers will be 
notified via e-mail whenever 
a software update is released. Update announcements are also posted to the 
What’s New @ Clients & Profits web page (www.cnp-x.com/whats_new). 
Clients & Profits X users with access privileges to Software Update will be 
notified of new updates whenever they start the software. 

Updates are not available as stand-alone installers or on CD. An internet con-
nection is required to download software updates. 

To update Clients & Profits X

1  Choose Setup > Software Update.

The Software Update window opens and starts checking for new updates. 
If your copy of Clients & Profits X is up-to-date, you’ll be alerted that your 
software is current. But if a new update is available, Clients & Profits X will 
display the update’s version name, release date, and release notes in the 
window. 

2  Click on the Install button to install the update now.Most software updates 
will take only a few minutes to download, depending on the number of 

enhancements or fixes included. You’ll need to repeat these steps on each 
workstation that uses Clients & Profits X.

■  Since Clients & Profits X is a multi-user application, it’s important that 
everyone always use the same version of the software. Since some system 
managers prefer to test a new update with a backup copy of the agency’s 
database first, Clients & Profits X doesn’t automatically check for software 
updates for users who don’t have access privileges to software update. This 
also helps ensure that everyone in the shop is using the same version.

To print an update’s 
release notes

1 Click on the Print button.

More information about soft-
ware updates can be viewed 
from
www.cnp-x.com/downloads/
release_notes.html
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While most of the database administration of the Clients & Profits X database 
will be performed within the application itself, the MySQL 5 server needs to 
be initially configured for Clients & Profits X. This section features step-by-
step instructions for doing a generic configuration of a Clients & Profits X 
database for MySQL on an Xserve. These instructions assume that MySQL 5 is 
already installed and operating. 

These instructions explain how to setup the MySQL server for the 
C&P X tutorial database, which is just one of several databases 
you might use. Each database you’ll use, such as the sample 
training database and your shop’s actual database, are configured 
separately following these same steps. To configure the sample 
database, starter database, or another database, substitute its 
name and details wherever the word “tutorial” appears in these 
instructions.

In this section, you’ll do these steps:

1)  Create a C&P X tutorial database using the MySQL Administrator
2)  Start Clients & Profits X then import the tutorial data

Estimated time:  30 minutes

■  These instructions will setup a minimum configuration of MySQL for Clients 
& Profits X. There are many settings that can and should be customized for 
your specific work environment (such as backing up data). The C&P Helpdesk 
does not provide support for tuning MySQL databases. You will need the 
services of an experienced MySQL DBA to optimize your system.

■  If you are a non-technical Clients & Profits system manager, you should get 
assistance from an experienced MySQL DBA to configure the server.

To configure your Xserve for Clients & Profits X

To configure your Xserve for Clients & Profits X and MySQL, you’ll first need 
to install the C&P X application onto the server. It will be used to initially set 
up your Clients & Profits X database, then used only to maintain the database. 
You’ll first need to install MySQL 5 and the MySQL Administrator software 
(http://dev.mysql.com/downloads/administrator).

Before using Clients & Profits X, you’ll need to configure MySQL Pro for each 
database. There are two sample databases you’ll need to configure: (1) the 
tutorial database, which is used for new user training or evaluating the Clients 

Configuring MySQL 5 for C&P X

Configuring MySQL 5 for 
Clients & Profits X

& Profits X and (2) the sample database that you’ll use for testing reports. The 
databases can be found at: www.cnp-x.com/downloads

To use these databases with Clients & Profits X, they need to be imported 
into the MySQL database. The import process is mostly automatic, but MySQL 
needs to be first configured to handle each database. Once imported, users 
can start working with these databases.

■  While most shops only have one database, an unlimited number of data-
bases can be maintained by Clients & Profits X. In some cases, companies 
with different businesses (such as an autonomous PR company) would create 
a separate database for each unit. Each database has a unique name and set 
of authorized users. All of the company’s databases would be stored in MySQL 
and opened as needed. However, Clients & Profits X can only open one data-
base at a time on a workstation. 

To create a C&P X tutorial database using the MySQL Ad-
ministrator

The MySQL Administrator application lets you add new databases, monitor the 
server’s performance, as well as make and restore backups. You’ll use it to set 
up every database you need for Clients & Profits X. 

1  Open the MySQL Administrator application.

2  At the login prompt, enter your Xserve’s IP address and your administrator 
name and password then click Connect.

           

The Information window opens, displaying the MySQL server’s current status. 
This window shows you whether or not the server is running (“server status”) 
and the version of MySQL you’re currently running.

DATABASE INFORMATION

Database name:

Server IP Address:        .        .        .       .
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3  Click on the Catalogs (i.e., databases) button to list the databases currently 
set up in MySQL.

4  Click the “+” button to add a new database (i.e., “schema”).

5  Name the “schema” (i.e., your database) as tutorial when prompted. 

The name of the database is very important. Each Clients & Profits X user will 
need to type in the Xserve’s IP address and the this name when they first con-
nect to a database. Shorter names are easier to remember.

6  Quit the MySQL Administrator.

An empty tutorial database has now been created in MySQL, but can’t be used 
until data is imported from Clients & Profits X.

7  Start the Clients & Profits X application. 

8  At the Introduce Yourself prompt, enter your user ID as ROOT then press 
Tab.

            

9  Enter your MySQL administrator password, if changed, or leave it blank and 
press Tab.

10  Click on the Database drop-down menu and choose “MySQL”.

11  Enter the Xserve’s IP address, then a forward slash, then the database’s 
name then click Connect.

Clients & Profits X will then connect to the MySQL server via TCP/IP. When 
the connection is successful and the selected database is opened, C&P X will 
know that the database is empty and prompt you to import data from an exist-
ing C&P 5.x or 10.x database or use starter data.

12  When prompted, click on the Import Data button then locate and open 
your Tutorial.df1 database on the Xserve’s hard drive (it should be in your C&P 
X folder).

      

■  If you’d clicked the New Database button, a starter set of tasks, status 
codes, G/L accounts, groups, and more would have been automatically im-
ported into your new MySQL database. 

On an Xserve, the import process takes about one hour per 100 megabytes. 
While the data is being imported, no one should use the MySQL Administra-
tor or Clients & Profits X.  Once the data is completely imported, a report will 
print summarizing the new database. Once the report prints, the database is 
ready to use.

No more Database Utilities  Your clients, jobs, costs, etc. are now 
stored in MySQL, not in the built-in Clients & Profits database -- the 
familiar .DF1 file. Since the data is now completely managed by 
MySQL, you won’t use the C&P Database Utilities for importing, ex-
porting, Quick Check, backing up, reindexing, etc. All data handling 
is now a function of MySQL. 
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Configuring SQL Server 2008 for 
Clients & Profits SQL X

1-1  Choose Start > Programs > Microsoft SQL Server 2008 > Microsoft SQL 
Server Management Studio.

The Connect to Server window opens, prompting you for your SQL Server 
database name, login name and password.

1-2  Choose a server name from the Server Name combo box, or enter your 
SQL server’s IP address.

1-3  Click on the Authentication combo box and choose SQL Server Authenti-
cation.

1-4  Enter the server’s system administrator login name (for example, “sa”) 
and password then click Connect.

1-5  Expand Databases by clicking on the (+). 

While most of the database administration of Clients & Profits X will be per-
formed within the application itself, the SQL Server 2008 (or SQL Server 2008 
Express) needs to be initially configured for Clients & Profits X. This section 
features step-by-step instructions for doing a generic configuration SQL Server 
2008 for Clients & Profits X on a Windows 2003 server. The configuration 
process has many steps, and each set of steps is distinctly numbered. These 
instructions assume that your SQL Server 2008 server is already installed and 
operating. 

These instructions explain how to setup the SQL Server 2008 file 
server for the C&P tutorial database, which is just one of several 
databases you might use. Each database you’ll use, such as the 
sample training database and your shop’s actual database, are 
configured separately following these same steps. To configure the 
sample database, starter database, or another database, substitute 
its name and details wherever the word “tutorial” appears in these 
instructions.

In this section, you’ll do these steps:

1)  Create a C&P tutorial database using the SQL Server Enterprise Manager
2)  Setup the data source for the ODBC driver 
3)  Start Clients & Profits X then import the tutorial data

Estimated time:  2 hours

■  These instructions will setup a minium configuration of SQL Server 2008 for 
Clients & Profits X. There are many settings that can and should be custom-
ized for your specific work environment (such as backing up data). The C&P 
Helpdesk does not provide support for tuning SQL Server databases. You will 
need the services of an experienced SQL Server DBA to optimize SQL Server 
2008 for Clients & Profits.

■  If you are a nontechnical Clients & Profits system manager, you may want 
assistance from an experienced SQL Server DBA to configure the server.

1) To create a C&P X tutorial database using the SQL Server 
2008 Management Studio

You’ll need to know the name of the machine that’s running SQL Server and 
database information to configure the Clients & Profits X workstations. For 
convenience, enter the server’s name here (see step 1-9):

DATABASE INFORMATION

Database name:

Server Name:
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1-6  Right-click on the Databases folder and choose New Database.

1-7  Name the new database tutorial then click OK. 
 
You’ll see the new tutorial database listed inside the Databases folder.

2) To create a data source name on SQL Server 2008

2-1  Choose Start > Programs > Administrative Tools > Data Sources (ODBC)

The ODBC Data Source Administrator window opens, which where you’ll add 
the data source for the tutorial database.

2-2  Click Add.

2-3  Select SQL Native Client from the driver list and then click Finish.

The Create a New Data Source window opens, prompting you to enter the 
name of the tutorial database and its server name.

2-4  Enter the name as tutorial, the description as Clients & Profits 
X, then choose the server name from the combo box (or enter the server’s IP 
address).

The next window will prompt you to choose a method of authentication.

2-5  Click on the “with SQL Server authentication” radio button, enter the 
server administrator login name (“sa”) and password, then click Next.

The DSN Configuration window will now prompt you to change the default 
database.

Configuring SQL Server 2008 for C&P X
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Configuring the SQL Server 2008 Database Server for C&P X

Configuring the SQL Server 2008 
Database Server (con’t)

2-6  Click on the “change default database” checkbox then select tutorial 
from the combo box then click Next.

2-7  Click Finish at the next DSN Configuration window to keep the standard 
settings.

You’ll then be prompted to test the SQL Server data source for the tutorial 
database.

2-8  Click Test Data Source then click OK to confirm the database was con-
nected successfully, click click OK again to complete the data source setup.

The tutorial database has now been successfully created on the SQL Server 
2008 Server and is now ready for client, job, and accounting data. The final 
step is to import the sample tutorial data into your new database.

3)  To import the tutorial data 
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The first time a C&P X user connects to a SQL Server database, Clients & Prof-
its X will prompt you to initialize it. This process sets up SQL Server 2008 for 
the Clients & Profits X tutorial database, copying over its tables then import-
ing the clients, jobs, costs, and other sample records into SQL Server tables. 
Once the tutorial database is imported, users can start C&P X and access the 
tutorial database. 

■  Importing data into a new SQL Server 2008 database can only be performed 
from a Windows-based PC running C&P X.    

These steps will be repeated for every C&P X database you want to use with 
SQL Server 2008, such as the sample training database, and existing Clients & 
Profits databases you’re currently using.

3-1  Choose Start > Programs > Clients & Profits X then select the Clients & 
Profits X application.

Because you haven’t yet registered the software, you’ll be prompted to choose 
an edition (e.g., C&P Pro, Job Tracker, or C&P Enterprise Edition). Once you 
register your software, this step will be skipped.

3-2  Select SQL Server 2008 from the Database drop-down menu, 

3-3  Enter the login initials as SA (“system administrator”) and the server 
administrator’s password.

■  You’ll only enter your initials as SA (the “system administrator”) the first 
time a C&P database is initialized. Once the data is imported, users will access 
the database by entering their own initials and passwords.

3-4  Enter the database’s name, which is the DSN name from the ODBC Data 
Sources setup window, then click Connect.

Clients & Profits X will now start an ODBC session with SQL Server, connect-
ing to the tutorial database you just set up. The first time a new database is 
opened, you’ll be prompted to initialize the database.

3-5  From the Initialize window, click the Import Data button.

3-6  Find the tutorial.df1 database in the Clients & Profits X folder then click 
OK.

Clients & Profits X will now import all of the tutorial data into SQL Server. 
When the import is complete, a log will print that can be used to look for 
conversion errors. This database is now ready to use.
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Configuring Mac OS X Users for 
SQL Server 2008

Clients & Profits X is installed separately on every Mac computer running Mac 
OS X 10.4 (or higher) that needs it. The installation steps generally the same 
as other Mac applications: 

1)  Install the Clients & Profits X software on a workstation
2)  Install the Actual Technologies OBDC client driver (not included)
3)  Configure the Actual OBDC to connect to your C&P X database
4)  Start C&P X then log onto to your database
5)  Activate your C&P X software

Estimated time:  20 minutes

■  Mac OS X can’t connect to SQL Server 2008, unlike MySQL, without the Ac-
tual OBDC driver for SQL Server, which must be purchased separately for each 
Mac workstation. Step-by-step installation instructions are included here, but 
the C&P Helpdesk offer only limited supports for the Actual ODBC driver. To 
purchase or get technical support, please visit www.actualtechnologies.com.

If you are not the SQL Server database administrator (“DBA”), there are several 
SQL Server settings that you’ll need to know (see the chart below) before in-
stalling Clients & Profits X. These settings are based on how SQL Server 2008 
was configured for your C&P X databases.   

Clients & Profits X does not install any system files and doesn’t modify your 
Mac OS X configuration.

■  Clients & Profits X should be installed on every user workstation who will 
use it. For better performance, always run the C&P X application from a local 
workstation, not from the file server.

To install the Clients & Profits X software

1  Download the C&P X installer from www.cnp-x.com/downloads.

2  Double-click on the C&P X installer.

3  Follow the prompts for both Clients & Profits X and the Actual ODBC driver.

The Clients & Profits X software and the demo version of the Actual ODBC 
drivers should be installed in less than a minute.

To register the Actual ODBC driver

A demo version of the Actual ODBC driver is installed automatically when you 
install Clients & Profits X.  The demo has a limit of three records per transac-
tion until it is registered. Before using Clients & Profits X for real work, you’ll 
need to register the ODBC driver.

1  Buy the Actual ODBC driver from: https://www.actualtechnologies.
com/buynow.php

2  Write down the license key, which you’ll need for step 4 (see page 25).

To configure the Actual ODBC driver for C&P X

Both SQL Server 2008 and Clients & Profits X allow users to access many 
different databases. For example, a tutorial database works with the Clients & 
Profits X tutorial to help new users learn the system. 

Your shop will generally have one database for its clients, jobs, and account-
ing. If the company has different businesses, then each business may have its 
own database. When Clients & Profits X is started, it prompts you to connect 
to one of your databases. Each database is called a service and has to be 
configured on each workstation by the Actual ODBC driver. 

1  Choose Go > Utilities > then double-click on the ODBC Administrator ap-
plication.

The Actual Technology’s OBDC Administrator program opens, displaying the 
Administrator window. This windows lists the SQL databases to which you can 
connect. The list is empty if you haven’t yet configured any SQL databases.

 SQL Server 2008 / C&P X DATABASE INFO

C&P TUTORIAL database info (Tutorial.DF1)

Database name:

Server Name:          

C&P SAMPLE database info (CP_Sample.DF1)

Database name:

Server Name:          

Your shop’s Clients & Profits X database info:

Database name:

Server Name:          
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2  Click on the User DSN tab then click the Add button.

You’ll be prompted to choose an ODBC driver from the list:

3  Click once on the Actual SQL Server driver to select it, then click Finish.  

4  Click on the Licenses button then enter your license key (i.e., serial number) 
then click OK. 

5  Click Continue to create a new data source to SQL Server. You’ll then be 
prompted to enter the new data source’s name, description, and server loca-
tion.

6  Enter the database name as CP_TUTOR and a short description of the 
database (e.g., “C&P tutorial”), then enter the database server’s IP address and 
click Next.  
 
The database name refers to a single specific database that’s inside SQL Server 
2008. If your shop uses several Clients & Profits databases, each one will have 
its own unique name. A database’s name will never change. 
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If the connection fails, make sure the server’s address and port numbers are 
set properly:  

 
7  Unlike configuring the ODBC connection for a Window client, in order to 
use NT authentication the client login ID and password need to be set in this 
window.   

Click on the checkbox labeled “Connect to SQL Server to obtain default set-
ting” then click Continue.

8  Change the default database to tutorial then click Continue.

9  Accept the default settings, then click Continue.

 
10  Click Test to check that your settings are correct.

 
If your connection was successful, you’ll see this:

Configuring Mac OS X Users for 
SQL Server (con’t)

Configuring Mac OS X Users for SQL Server 2008
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11  Click OK to complete the configuration and introduce yourself (i.e., log in) 
to Clients & Profits X.

12  Enter your C&P X user ID and password (or MGR if you don’t have one) and 
the server name then click Connect.

 

You are now connected to your Clients & Profits X database.

 

To connect to other Clients & Profits X databases 

You’ll need use the same steps shown previously, except you’ll enter the other 
database’s name, and the Server IP address or name (which will probably be 
the same), and select the new database as default. 

Only one database can be opened at one time from a workstation, but it’s 
easy to switch from one to another. Every time Clients & Profits SQL is started, 
you’ll be prompted to connect to a database by entering the service name 
(e.g., CP_ACCT). To later switch to a different database, choose File > Intro-
duce Yourself (Log On) then enter a database’s service name.

Configuring Mac OS X Users for SQL Server 2008
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Configuring Windows Users for 
SQL Server 2008

Clients & Profits X is installed separately on every Windows-based PC that 
needs it. The installation steps generally the same as other applications: 

1)  Install the Clients & Profits X software on a workstation
2)  Setup a data source for the Server 2005 ODBC driver to the C&P database 
3)  Start C&P X then connect to your SQL Server 2008 database
4)  Activate your C&P X software

Estimated time:  20 minutes

If you are not the SQL Server database administrator (“DBA”), there are several 
SQL Server settings that you’ll need to know (see the chart below) before in-
stalling Clients & Profits X. These settings are based on how SQL Server 2008 
was configured for your C&P X databases.  

Clients & Profits X does not install any system DLL files and doesn’t modify 
your Windows registry or configuration.

■  Clients & Profits X should be installed on every user workstation who will 
use it. For better performance, always run the C&P X application from a local 
workstation, not from the file server.

To install the Clients & Profits X software

1  Download the C&P X installer from http://www.cnp-x.com/downloads.

2  Double-click on the installer to install the software.

3  When prompted, click Next to continue the setup.

To setup a datasource for the SQL Server 2008 ODBC driver

Both SQL Server 2008 and Clients & Profits X allow users to access many 
different databases. For example, a tutorial database works with the Clients 
& Profits X tutorial to help new users learn the system. Your shop will gener-
ally have one database for its clients, jobs, and accounting. If the company 
has different businesses, then each business may have its own database. 
When Clients & Profits X is started, it prompts you to connect to one of the 
databases. Each database is called a service and has to be configured on each 
workstation. 

1  Choose Start > Control Panel > Performance and Maintenance > Adminis-
trative Tools > Data Sources (ODBC).

If you don’t have the ODBC data sources icon, it usually installs with programs 
that use ODBC access, like Crystal reports, Microsoft Access, or Microsoft 
Excel.

2  From the User DSN, click add.

3  Select the SQL Server, then click Finish.  

SQL Server 2008 / C&P X DATABASE INFO

C&P TUTORIAL database info (Tutorial.DF1)

Database name:

Server Name:          

Your shop’s Clients & Profits X database info:

Database name:

Server Name:          
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■  Note:  The instructions for setting up the ODBC driver are for version 3.x or 
above.  If your driver is version 2.x or below the setup is different.

4  Enter the database Name as tutorial and a database description.  If 
you are using Windows 2000 or XP, choose the server name (if your using 
Windows 98 you must type in the server name). Click Next.  

 
The “name” refers to a single specific database that’s inside SQL Server 2008. 
Each Clients & Profits X database will have its own unique name. A database’s 
name will never change. 

5  Accept the default settings, then click Next.

6  Change the default database to tutorial, click Next.

7  Accept the default settings, then click Next.

8  Click Test Data Source to check your settings.
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